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Welcome to 2017 Knowledge-Based Audits, Preparations, Compilations and Reviews™ of Common Interest Realty
Associations for ProSystem fx® Knowledge Coach
This Release Notes document provides important information about the 2017 release of Knowledge Based Audits, Preparations,

Compilations and Reviews ™ of Common Interest Realty Associations. Please review this information carefully. If you have any
questions, contact Customer Support at 1-800-PFX-9998. Additional information is available on CCH Support Online.

New in this Release

Knowledge-Based Audits, Preparations, Compilations and Reviews of Common Interest Realty Associations (CIRAs) is designed to help
the practitioner efficiently and effectively perform financial statement audits of common interest realty associations in accordance with
auditing standards generally accepted in the United States (U.S. GAAS), and preparations, compilations, and reviews of common
interest realty associations in accordance with Statements on Standards for Accounting and Review Services (SSARSs) issued by the
American Institute of Certified Public Accountants (AICPA).

The Knowledge-Based Audit is a risk-based methodology that emphasizes using knowledge of the CIRA to make risk assessments in
connection with a financial statement audit. This allows the auditor to more appropriately focus audit efforts on those areas which in
the auditor’s judgment are the most significant and pose the most risk to the financial statement audit. The operations of CIRAs are
often unique and complex and require specialized accounting and auditing knowledge. This edition includes specific up-to-date
guidance for auditing CIRAs. Conducting audits of CIRAs requires the exercise of the auditor’s professional judgment.

The Knowledge-Based Preparations, Compilations and Reviews Methodology emphasizes using knowledge of the CIRA to perform
preparation, compilation, and review engagements by facilitating the flow of information so that the understanding obtained in each
process affects the decisions made in the next. Although the accountant will likely perform most steps in this methodology
sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities
helps the accountant design and customize engagement procedures; evidence gained from procedures performed is evaluated and the
appropriate accountant’s report, if any, is issued. This edition includes specific up-to-date guidance for conducting preparation,
compilation, and review engagements of CIRAs in accordance with the SSARSs.

The operations of CIRAs are often unique and complex and require specialized accounting and auditing knowledge. This edition includes
specific up-to-date guidance for performing attestation engagements of CIRAs.

Conducting audits and attestation engagements of CIRAs requires the exercise of the auditor’s professional judgment. This document is
published for the purpose of communicating, to users of the toolset, updates and enhancements included in the current version. This
document is not, and should not be used as an audit program to update the audit documentation of an engagement started in a
previous version of this product.

This document is published for the purpose of communicating the updates and enhancements included in the current version to users
of the toolset. This document is not, and should not be used as an audit program to update the audit documentation of an engagement
started in a previous version of this product.

This is the sixth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2017 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

This module includes separate titles for Audit, Preparation, Compilation, and Review Engagements. Each title will need to be
downloaded separately.

The 2017 Knowledge-Based Audits of Common Interest Realty Associations also features numerous enhancements, including:
¢ Adding a tailoring question in AUD-100 in response to SAS No. 130, which asks if the auditor will be performing an integrated

audit. This tailoring question will show/hide procedures in AUD-101, AUD-701, AUD-901, KBA-201, KBA-412, KBA-904, AID-601,
and AID-903 based on the user’s answers.


http://support.cch.com/productsupport/

¢ AUD-903 and AUD-904 have been streamlined and minimized for duplication elsewhere. Some steps in AUD-903 have been
moved to KBA-501.

¢ AUD-802 Audit Program: Securities, Derivatives, and Hedging has been split into AUD-802A Audit Program: Investments in
Securities and AUD-802B Audit Program: Derivative Instruments and Hedging Activities.

¢ The Investment in Securities, Derivative Instruments, and Hedging Activities audit area from the 2016 CIRA Audit Title is now
split into two separate audit areas: 1) Investments in Securities and 2) Derivative Instruments and Hedging Activities.

¢ Anew table has been added to KBA-101 for users to document why the auditor isn’t testing the operating effectiveness of
internal controls. If the auditor has selected in AUD-100 that the auditor is performing an integrated audit or operating
effectiveness of internal controls will be tested, this table will be hidden.

KBA-105 has been reorganized so that the user will add entries to column 1 instead of column 3 so the flow is more logical.

New columns have been added to AID-701 which will allow the user to select whether the assertion is relevant or not. For any
assertion marked as not relevant, the user will NOT need to complete the planned level of control risk. The selections made in
this new column will flow to other areas of the workpaper.

A comments column has been added to KBA-400 Scoping and Mapping Table and in KBA-502 Assertion Level Risk Table.

An option for a Not Applicable answer has been added to question 9 of AUD-602.

A new Not Applicable option has been added in KBA-103 column 15, “If Not a Material Weakness, Is It Important Enough to
Merit Attention by Those Charged with Gov.?”

¢ There are many new CORs, RPTs and RESs including:

@)
@)

(@)

O O O O O O

COR-201A Audit Engagement Letter: Integrated Audit

COR-202A Audit Engagement Letter: Integrated Audit When Also Performing Reviews of Interim Financial
Information

COR-901A Management Representation letter: ICFR

COR-904A Communication to Entity with Significant Deficiencies and/or Material Weaknesses: ICFR

RPT-0901A Unmodified Opinion: Single-Year Financial Statements—Combined Report Expressing an Unmodified
Opinion on ICFR

RPT-0901B Unmodified Opinion: Single-Year Financial Statements with Reference Made to Separate Report on ICFR
RPT-0902A Unmodified Opinion: Comparative Years Financial Statements—Combined Report Expressing an
Unmodified Opinion on ICFR

RPT-0902B Unmodified Opinion: Comparative Financial Statements with Reference Made to Separate Report on ICFR
RPT-0919A Unmodified Opinion on Internal Control over Financial Reporting When Making Reference to the Report
of a Component Auditor

RPT-0928 Unmodified Opinion: Special-Purpose Financial Statements Prepared in Accordance with the Financial
Reporting Framework for Small and Medium-Sized Entities

RPT-0960 Unmodified Opinion: Separate Report on ICFR

RPT-1004 Adverse Opinion: Separate Report on ICFR

RPT-1019 Disclaimer of Opinion: Separate Report on ICFR

RES-024 Special Considerations in Auditing Financial Instruments

RES-025 Illustrative Management’s Report on Internal Control over Financial Reporting

RES-026 Considerations of an Audit of Internal Control over Financial Reporting That Is Integrated with the
Knowledge-Based Audit of Financial Statements

The 2017 Knowledge-Based Preparations, Compilations and Reviews of Common Interest Realty Associations also features numerous
enhancements, including:

¢ Many new and modified procedures and steps in all three titles for better clarification and compliance with current accounting
guidance. See KCO-001 for roll forward considerations.

¢ There are many new CORs including:

o

COR-221B Engagement Letter: Preparation of Financial Statements in Accordance with Accounting Principles
Generally Accepted in the United States of America Omitting the Statement of Cash Flows and Substantially All
Required Disclosures.

COR-221C Engagement Letter: Preparation of Financial Statements in Accordance with the Tax Basis of Accounting.
COR-221D Engagement Letter: Preparation of Financial Statements in Accordance with Prescribed Format.



o COR-221E Engagement Letter: Preparation of an Element, Account, or Item of the Financial Statements in Accordance
with Accounting Principles Generally Accepted in the United States of America.

o COR-226B Engagement Letter: Review of Element, Account, or Item of a U.S. GAAP Financial Statement

o COR-234 Engagement Letter: Management's Acknowledgement and Acceptance of Its Responsibilities in a
Preparation Engagement When Understanding Is Established with Governance.

o COR-235 Engagement Letter: Management's Acknowledgement and Acceptance of Its Responsibilities in a
Compilation Engagement When Understanding Is Established with Governance.

o COR-236 Engagement Letter: Management's Acknowledgement and Acceptance of Its Responsibilities in a Review
Engagement When Understanding Is Established with Governance.

Click here for the 2017 Knowledge Based Audits of Common Interest Realty Associations Title Overview for Knowledge Coach Users

Click here for the 2017 Knowledge Based Preparations, Compilations, and Reviews of Common Interest Realty Associations Title
Overview for Knowledge Coach Users

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:

New literature, standards, and developments, reflected in the following current audit and accounting guidance:

Audit Title
¢ SAS No. 131, Amendment to Statement on Auditing Standards No. 122 Section 700, “Forming an Opinion and Reporting on
Financial Statements” (AU-C Section 700)
¢ SAS-130, An Audit of Internal Control Over Financial Reporting That Is Integrated With an Audit of Financial Statements (AU-C
Section 940)
¢ Revised AICPA Code of Professional Conduct (Code) including ET Section 1.295, Nonattest Services; and
¢ FASB Accounting Standards Codification™ as of March 31, 2017, through Accounting Standards Update No. 2017-07

Preparation, Compilation and Review Titles

¢

Statement on Standards for Accounting and Review Services No. 21 (SSARS No. 21), Clarification and Recodification (including
AR-C Section 70, Preparation of Financial Statements; AR-C Section 80, Compilation Engagements; and AR-C Section 90,
Review of Financial Statements);

Statement on Standards for Accounting and Review Services No. 22 (SSARS No. 22), Compilation of Pro Forma Financial
Information;

Statement on Standards for Accounting and Review Services No. 23 (SSARS No. 23), Omnibus Statement on Standards for
Accounting and Review Services — 2016;

AICPA Statement on Quality Control Standards No. 8, A Firm's System of Quality Control (Redrafted) (QC Section 10);

The revised AICPA Code of Professional Conduct (Code), often referred as the AICPA Ethics Codification Project, including ET
Section 1.295, Nonattest Services);

AICPA Audit Risk Alert Developments in Review, Compilation, and Financial Statement Preparation Engagements—2015/16;

ARSC exposure drafts (EDs) issued December 2015 and primarily designed to incorporate the compilation of prospective
financial information, which will be AR-C Section 110, and the compilation of pro forma financial information, which will be AR-
C section 120, into SSARS in the clarified format.

Important Notes

¢
¢

Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open.
o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.
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¢ Asof the December 2016 update to Engagement 7.5 and Knowledge Coach 2.5, you can open binders that contain Knowledge
Coach workpapers when logged into the Shared File Room (SFR) mode in Engagement with the following restrictions:

o Knowledge Coach workpapers cannot be edited in the SFR mode.

o However, Knowledge Coach workpapers can be viewed as read-only, signed off on, and workpaper notes can be
written on Knowledge Coach workpapers while in the SFR mode.

o Non-Knowledge Coach workpapers can be edited in SFR mode without restriction.

System Requirements

¢ This title MUST be used with ProSystem fx ® Engagement version 7.5 or higher, ProSystem fx® Knowledge Coach version 2.5,
and 2016 Financial Statement Base v4 or higher. If you have not installed the ProSystem fx® Engagement 7.5 and Knowledge
2.5, ensure that you do so before using this title. If you are upgrading from ProSystem fx® Engagement 7.1 or lower please
contact Technical Support at 1-800-PFX-9998 for detailed instructions.

¢ A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions

The 2017 Knowledge-Based Audits, Preparation, Compilation, and Reviews of CIRAs includes the Audit, Preparation, Compilation, and
Review title packages which are four separate packages.

Download the 2017 Knowledge Based Audits, Preparations, Compilations and Reviews of CIRAs from the ProSystem fx ®Knowledge
Coach Updates section of the ProSystem fx® Engagement Support Web site at the following URL:
http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge Coach Series (Audit, Preparation, Compilation or Review)
and Download file link next to the 2017 Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs. On some occasions
the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of the
downloaded file to KCP using all capital letters.

You must install the 2016 Financial Statement Base v4 title before installing the 2017 Knowledge Based Audits, Preparations,
Compilations and Reviews of CIRAs.

The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

Important: ProSystem fx® Engagement version 7.5 or higher and Knowledge Coach version 2.5 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2010, Microsoft® Office 2010 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The Knowledge Coach Content Package (KCP) is a proprietary file that must be installed from within Engagement. Save this KCP file to a
location on your local drive and follow the Installation Instructions included in the Release Bulletin.

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2017 Knowledge Based Audits, Preparations, Compilations and Reviews of CIRAs, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.
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¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.

¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:
¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”

Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.

Important: Once the 2017 Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs titles have been added and
released, they will be automatically deployed to other staff members when they login to the “Office” location, or when they
synchronize a binder that contains Knowledge Coach workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.5 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2017
Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs.

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Accounting Research Manager

CCH's Accounting Research Manager ("ARM") is the most comprehensive, up-to-date and objective online database of financial
reporting literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Available on ARM, the Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs Guide helps you comply with the
most recent professional standards and guidance for the conduct of audits of Employee Benefit Plans and to integrate the use of
practice aids, tools, and other resources with its guidance. This publication supplements and complements the Knowledge-Based
documents that are available in Knowledge Coach.

If you subscribe to an ARM library that includes CIRAs content, you can link directly to source material from Resources within
Knowledge Coach documents. These links have been updated to refer to the accounting standards under the FASB Accounting
Standards Codifications. Also, if you subscribe to the Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs Guide
on ARM, you can take advantage of references to the guide material from within the Knowledge Coach documents.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.

Using Your Knowledge Coach Content

To use your Knowledge Coach Workpaper Templates, open a binder in ProSystem fx® Engagement, select the workpaper tab into which
you would like to insert the workpaper, and select New Knowledge Coach Workpaper from the toolbar or File menu. The New
Knowledge Coach Workpaper dialog appears (Figure 1).
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Select the New Knowledge Coach Title with the content you would like to use. You can only select titles you have installed. The
information displayed changes to reflect the workpaper organization available for the selected title.

Select the Knowledge Coach Workpaper Templates to insert into your binder and click OK. The Selected Workpaper Properties dialog
appears. Each workpaper name is automatically loaded into the Name field. Add a workpaper index in the Index field and make any
Name modifications you desire. You can also modify the tab location or the roll forward settings for each workpaper. Then click OK.

The integrated Knowledge Coach workpaper is now inserted into your engagement binder. For more information on how to use
Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.

Industry title selection Workpaper selection

S |Q | [] Add independent workpapers without foundation workpapers
2017 KBA CIBA Audits D 000-Resources Details of selected workpaper
2017 KBA CIRA Compilstions D 100-The Communications Hub

2017 KBA CIRA Preparation

3017 KBA CIRA Reviews -]  200-Pre-Engagement Procedures

300-Risk Assessment-Understanding the CIRA & Environment
; 4D0-Risk Assessment-Design of Intemal Controls

D 500-Aszessing Risk of Matenal Misstatement

D 600-Audit Procedures-Response to Assessed Risks Highlight a workpaper or select
-] 700-Audt Procedures-Tests of Intemal Cortrols a workpaper check box to see
@] 800-Audit Procedures-Substantive Tests details.

@[]  900-Evaluating. Concluding & Reporting Procedures

Cancel Help

Figure 1 - New Knowledge Coach Workpaper

Additional Information on Knowledge Coach and the KBA Methodology

Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:

¢ An Overview that guides auditors through the methodology;

¢ Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by GAAS;

¢ Customizable Audit Programs that take auditors through related steps and procedures;

¢ Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programs;

¢ Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements; and

¢ Correspondence documents that provide sample letters to be used to comply with GAAS requirements and in many other
common situations.



The AICPA’s Auditing Standards Board’s (ASB) Risk Assessment Standards - The practice aids and tools in the 2017 Knowledge-
Based Audits, Preparations, Compilations and Reviews of CIRAs are designed around the AICPA's risk assessment and clarified
standards to assist auditors of CIRAs by:

e Facilitating compliance with SSARS;

e Encouraging more effective audits through tailored audit programs and comprehensive practice aids;
e Helping auditors to focus on and respond to identified audit risks; and

e Enhancing audit documentation.

Knowledge-Based Preparation, Compilation and Review (KBPCR) Methodology - Allows the results of one set of procedures to become
the input for the next. The key components of the KBPCR methodology include:

¢
¢

An Overview that guides practitioners through the methodology;

CIRA Preparation Programs, Compilation Programs and Review Programs that take accountants through related steps and
procedures designed for use in compilation and review engagements;

Practice Aids to help accountants complete steps or processes outlined in other related documents and provide example
financial statement formats for different types of entities;

Reports that provide a variety of sample accountant’s reports on compiled or reviewed financial statements;

Correspondence documents that provide sample engagement letters and management representation letters to be used in
many common situations; and

Knowledge-Based Preparation, Compilation and Review documents, integral to the overall engagement process, that contain
steps and procedures required by SSARSs.

The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2017 Edition of
Knowledge-Based Preparations, Compilations and Reviews of CIRAs are designed around the AICPA’s SSARS standards to assist
accountants by:

e Facilitating compliance with SSARS;
e Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids; and

e Enhancing audit documentation.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows auditors/accountants to use the Knowledge-Based-Audit methodology
more efficiently by eliminating the need for duplicate entry of the same information, tailoring audit documentation to each
particular engagement, and documenting the link between risks identified and procedures performed. AUD-100 Tailoring
Question, PRP-100 Tailoring Question Workpaper, CMP-100 Tailoring Question Workpaper or REV-100 Tailoring Question
Workpaper is a document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring the
engagement documentation to fit each client. Completing the questions helps the auditor avoid duplication and unnecessary
workpapers.

Before you begin your audit, preparation, compilation or review, please review the guidance in AUD-101 Overall Audit Program,
PRP-101 Overall Preparation Program, CMP-101 Overall Compilation Program or REV-101 Overall Review Program. This
workpaper is intended to be your road map through a Knowledge-Based Audit methodology. You should start your audit with
AUD-100 Tailoring Question Workpaper, PRP-101 Overall Preparation Program, CMP-100 Tailoring Question Workpaper or
REV-100 Tailoring Question Workpaper and AUD-101 Overall Audit Program, CMP-101 Overall Compilation Program or REV-
101 Overall Review, and AUD-101 Overall Audit Program.

In the Audit title only, risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the
current editor of KBA-502 Summary of Risk Assessments. This allows the user to continuously assess risks during the
engagement. Several workpapers prompt the consideration of the presence of risks, but the Risk Summary task pane must be
used to document those risks. All documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure
to check the “workpaper identified in” field of the Risk pane.



The Risk Assessment features have been disabled for the 2017 Knowledge-Based Preparations, Compilations and Review Title for
Knowledge Coach. Refer to KBP-101 Preparation: Significant Matters, KBC-101 Compilation: Significant Matters and KBR-102
Review: Significant Matters to accumulate and review significant issues and findings. PRP-801 Preparation Program, CMP-801
Compilation Program: Significant Risks and Uncertainties and REV-802 Review Program: Significant Risks and Uncertainties
provides a guide for implementing the guidance related to the disclosure of certain significant risks and uncertainties.

Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA.
Also, if you subscribe to the Knowledge-Based Audits, Preparations, Compilations and Reviews of CIRAs Guide on ARM, you can
take advantage of links to the audit guide material from within the Knowledge Coach documents.

Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH'’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.

2017 Knowledge-Based Audits of CIRAs, 2017 Knowledge-Based
Download Preparations of CIRAs, 2017 Knowledge-Based Compilations of
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The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
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